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ALL RIGHTS RESERVED 

You may print one (1) copy of this document for your personal use.  Otherwise, no part of this document may be reproduced, 
transmitted, transcribed, stored in a retrieval system, or translated into any language, in any form or by any means electronic, 
mechanical, magnetic, optical, or otherwise, without prior written permission from ALK Technologies, Inc. 

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other countries. 

IBM is a registered trademark of International Business Machines Corporation. 

PC*MILER®, CoPilot® Truck™, ALK®, RouteSync®, and TripDirect® are registered trademarks of ALK Technologies, Inc. 

Truck Stop location data © Copyright 2016 Comdata Inc, 5301 Maryland Way, Brentwood, TN 37027.  All Rights Reserved. 

Traffic information provided by INRIX © 2016.  All Rights Reserved by INRIX, Inc. 

SPLC data used in PC*MILER products is owned, maintained and copyrighted by the National Motor Freight Traffic Association, 
Inc. 

Canadian Postal Codes data based on Computer File(s) licensed from Statistics Canada. © Copyright, HER MAJESTY THE QUEEN 
IN RIGHT OF CANADA, as represented by the Minister of Industry, Statistics Canada 2003‐2016.  This does not constitute an 
endorsement by Statistics Canada of this product. 

Contains information licensed under the Open Government License – Canada.  
http://open.canada.ca/en/open‐government‐licence‐canada 

Xceed Software – The Software is Copyright © 1994‐2016 Xceed Software Inc., All Rights Reserved. The Software is protected by 
Canadian and United States copyright laws, international treaties and other applicable national or international laws. 

United Kingdom full postal code data supplied by Ordnance Survey Data © Crown copyright and database right 2016.  OS 
OpenData™ is covered by either Crown Copyright, Crown Database copyright, or has been licensed to the Crown. 

Certain Points of Interest (POI) data by Infogroup © Copyright 2016.  All Rights Reserved. 

Geographic feature POI data compiled by the U.S. Geological Survey. 

Oil and Gas field content provided by GeoTrac Systems Inc.© Copyright 2016.  All Rights Reserved. 

Cartographic data provided by multiple sources including lnstituto Nacional de Estadistica y Geografia, U.S. Geological Survey, 
Natural Earth and © Department of Natural Resources Canada. All Rights Reserved. 

Copyright HERE Data © 2016 – All Rights Reserved.  HERE Data © is subject to the terms set forth at 
http://corporate.navteq.com/supplier_terms.html . 

Source of map data for Mexico provided by Instituto Nacional de Estadistica y Geografia. 

All Retail Prices for Pilot Flying J locations are subject to change and are subject to Pilot Flying J’s disclaimer set forth at 
http://www.pilotflyingj.com/disclaimer . 

National Elevation Data produced by the U.S. Geological Survey. 

Satellite Imagery © Digital Globe, Inc.  All Rights Reserved. 

Weather data provided by Environment Canada (EC), U.S. National Weather Services (NWS), U.S. National Oceanic and 
Atmospheric Administration (NOAA), and AerisWeather. © Copyright 2016.  All Rights Reserved. 

Copyright SanGIS 2009 – All Rights Reserved. 

Data provided by permission of King County, Washington. 

ALK Data © 2016 – All Rights Reserved. 

ALK Technologies, Inc. reserves the right to make changes or improvements to its programs and documentation materials at any 
time and without prior notice. 

 
© Copyright 1994‐2016 ALK Technologies, Inc. • www.alk.com  
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PC*MILER® Product Line 
END-USER LICENSE AGREEMENT 

 
1.  Grant of License:  Subject to the terms, conditions, use limitations and payment 

of fees as set forth herein, ALK Technologies, Inc. ("ALK") grants the end-user 
("you") a non-assignable, non-transferable, non-exclusive license to install and 
use the PC*MILER solution(s) (including traffic data and fuel subscriptions) you 
have purchased ("PC*MILER") on a single personal computer.  The PC*MILER 
software, data and documentation are provided for your personal, internal use 
only and not for resale.  They are protected by copyright held by ALK and its 
licensors and are subject to the following terms and conditions which are agreed 
to by you, on the one hand, and ALK and its licensors (including their licensors 
and suppliers) on the other hand. 

 
2.  Title:  You acknowledge that the PC*MILER computer programs, data, concepts, 

graphics, documentation, manuals and other material owned by, developed by or 
licensed to ALK, including but not limited to program output (together, “program 
materials”), are the exclusive property of ALK or its licensors.  You do not secure 
title to any PC*MILER program materials by virtue of this license. 

 
3.  Copies:  You may make one (1) copy of the PC*MILER program materials, 

provided you retain such copy in your possession and use it solely for backup 
purposes.  You agree to reproduce the copyright and other proprietary rights 
notices of ALK and its licensors on such a copy.  Otherwise, you agree not to 
copy, reverse engineer, interrogate, or decode any PC*MILER program materials 
or attempt to defeat protection provided by ALK for preventing unauthorized 
copying or use of PC*MILER or to derive any source code or algorithms 
therefrom.  You acknowledge that unauthorized use or reproduction of copies of 
any program materials or unauthorized transfer of any copy of the program 
materials is a serious crime and is grounds for suit for damages, injunctive relief 
and attorneys' fees. 

 
4.  Limitations on Transfer:  This license is granted to you by ALK.  You may not 

directly or indirectly lease, sublicense, sell, disseminate, or otherwise transfer 
PC*MILER or any PC*MILER program materials to third parties, or offer 
information services to third parties utilizing the PC*MILER program materials 
without ALK's prior written consent.  To comply with this limitation, you must 
uninstall and deactivate PC*MILER from your computer prior to selling or 
transferring that computer to a third party. 

 
5.  Limitations on Network Access:  You may not allow end-users or software 

applications on other computers or devices to directly or indirectly access this 
copy of PC*MILER via any type of computer or communications network 
(including but not limited to local area networks, wide area networks, intranets, 
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extranets, the internet, virtual private networks, Wi-Fi, Bluetooth, and cellular and 
satellite communications systems), using middleware (including but not limited to 
Citrix MetaFrame and Microsoft Terminal Server) or otherwise (including but not 
limited to access through PC*MILER interface products), or install or use 
PC*MILER on a network file server, without first notifying ALK, executing a 
written supplemental license agreement, and paying the license fee that 
corresponds to the number and types of uses to which access is to be allowed. 

 
6.  Limitations on Data Extraction:  You may manually extract data (including but not 

limited to program output such as distances, maps, and driving directions) from 
PC*MILER and use it in other applications on the same computer on which 
PC*MILER is legally licensed and installed, as permitted below.  You may not 
transfer data extracted from PC*MILER onto any other computer or device 
unless you have licensed PC*MILER for that computer or device.  You agree that 
you will not, nor will you permit your trade partners or anyone else to, use 
content derived from PC*MILER, including route line data, nor display such data 
or integrate such data into another provider’s service, including, but not limited 
to, Google or Bing.  You agree not to pre-fetch, retrieve, cache, index, or store 
any data, content, or other portion of the product output at any time, provided, 
however, that you may temporarily store (for less than thirty (30) days) limited 
amounts of such content for the sole and exclusive purpose of enhancing the 
performance of your implementation due to network latency, and only if you do 
so securely and in a manner that: (a) does not permit use of the content outside 
of the scope of this Agreement; (b) does not manipulate or aggregate any 
content or portion thereof; (c) does not prevent ALK from accurately tracking 
usage; and (d) does not modify attribution of the product in any way. 

 
7. Limitations on Mobile Communications:  Without limiting the generality of the 

foregoing, you may not transmit PC*MILER street-level driving directions through 
mobile communications systems such as satellite, or cellular services or to 
mobile devices such as computers, telematics systems, on board or mobile 
computers or Smartphones, handhelds, pagers, electronic recording devices or 
telephones without first executing a written supplemental license agreement with 
ALK and paying the license fee that corresponds to the number and types of 
devices and systems to and through which transmission is to be permitted. 

 
8.  Limitations on Disclosure:  You may disclose PC*MILER distances to trading 

partners, in the course of their providing services to you, for specific origin-
destination moves for which you provide transportation services and use 
PC*MILER distances as a basis for payment.  You may not make any other 
disclosure of PC*MILER programs and materials, including, but not limited to, 
program output, to anyone outside the legal entity that paid for and holds this 
license, without prior written permission of ALK.  You acknowledge that the 
PC*MILER programs and materials, developed by or licensed to ALK are very 
valuable to ALK and its licensors, and their use or disclosure to third parties, 
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except as permitted by this license or by a written supplemental license 
agreement with ALK, is strictly prohibited. 

 
9.  Security:  You agree to take reasonable and prudent steps to safeguard the 

security of the PC*MILER program materials and to notify ALK immediately if you 
become aware of the theft or unauthorized possession, use, transfer or sale of 
the PC*MILER program materials licensed to you by ALK. 

 
10. Acceptance:  You are deemed to have accepted the PC*MILER program 

materials upon receipt.  
 
11. Warranties:  ALK represents and warrants that: 
  

a) For ninety (90) days from date of purchase, PC*MILER, when delivered and 
properly installed, will function substantially according to its specifications on a 
computer purchased independently by you. 
 
b) For ninety (90) days from date of purchase, the software media on which ALK 
provides PC*MILER to you will function substantially free of errors and defects.  
ALK will replace defective media during the warranty period at no charge to you 
unless the defect is the result of accident, abuse, or misapplication of the 
product.  
 
c) THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER 
WARRANTIES EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITING 
THE GENERALITY OF THE FOREGOING ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE.  THE 
PC*MILER PROGRAM, DATA AND DOCUMENTATION IS SOLD "AS IS". IN 
NO EVENT SHALL ALK OR ITS LICENSORS BE LIABLE FOR ANY 
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES SUCH AS, BUT NOT 
LIMITED TO, LOSS IN CONNECTION WITH OR ARISING OUT OF THE 
EXISTENCE OF THE FURNISHING, FUNCTIONING OR USE OF ANY ITEM 
OF SOFTWARE, DATA OR SERVICES PROVIDED FOR IN THIS 
AGREEMENT.  IN NO EVENT SHALL DAMAGES TO WHICH ALK MAY BE 
SUBJECT UNDER THIS AGREEMENT EXCEED THE CONTRACT PRICE.  
THIS WARRANTY SHALL NOT ACCRUE TO THE BENEFIT OF THIRD 
PARTIES OR ASSIGNEES. 

 
12. Disclaimer:  The data may contain inaccurate, incomplete or untimely 

information due to the passage of time, changing circumstances, sources used 
and the nature of collecting comprehensive geographic data, any of which may 
lead to incorrect results.  PC*MILER’s suggested routings, fuel and traffic data 
are provided without a warranty of any kind.  The user assumes full 
responsibility for any delay, expense, loss or damage that may occur as a result 
of their use.  The user shall have no recourse against Canada, whether by way 
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of any suit or action, for any loss, liability, damage or cost that may occur at any 
time, by reason of possession or use of Natural Resources Canada data. 

 
13. Termination:  This Agreement will terminate immediately upon any of the 

following events: 
 

a) If you seek an order for relief under the bankruptcy laws of the United States 
or similar laws of any other jurisdiction, or a composition with or assignment for 
the benefit of creditors, or dissolution or liquidation, or if proceedings under any 
bankruptcy or insolvency law are commenced against you and are not 
discharged within thirty (30) calendar days. 
 
b) If you materially breach any terms, conditions, use limitations, payment 
obligations, or any other terms of this Agreement. 
 
c) Upon expiration of any written supplemental license agreement between you 
and ALK of which this license is a part. 

 
14. Obligations on Termination:  Termination or expiration of this Agreement shall 

not be construed to release you from any obligations that existed prior to the 
date of such termination or expiration. 

 
15. Hold Harmless and Indemnity:  To the maximum extent permitted by applicable 

law, you agree to hold harmless and indemnify ALK and its parent company, 
subsidiaries, affiliates, officers, agents, licensors, owners, co-branders,  other 
partners, and employees from and against any third party claim (other than a 
third party claim for Intellectual Property Rights) arising from or in any way 
related to your use of PC*MILER, including any liability or expense arising from 
all claims, losses, damages (actual and/or consequential), suits, judgments, 
litigation costs and attorneys' fees, of every kind and nature. ALK shall use good 
faith efforts to provide you with written notice of such claim, suit or action. 

 
16. Disclosure for Products Containing Certain Data:  
 

a) Historical or Real-time Traffic data:  traffic data, including historical traffic 
data, is licensed as an optional subscription service which must be renewed 
annually for continued use.  ALK and its licensor(s) will use commercially 
reasonable efforts to make traffic data available at least 99.5% of the time each 
calendar month, excluding minor performance or technical issues as well as 
downtime attributable to necessary maintenance, and Force Majeure. 
 
b) Fuel data:  fuel data is licensed as an optional a subscription service which 
must be renewed annually for continued use.  
 
This data is provided to you “as is,” and you agree to use it at your own risk.  
ALK and its licensors (and their licensors and suppliers) make no guarantees, 
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representations or warranties of any kind, express or implied, arising by law or 
otherwise, including but not limited to, content, quality, accuracy, completeness, 
effectiveness, reliability, fitness for a particular purpose, usefulness, use or 
results to be obtained from this Data, or that the Data or server will be 
uninterrupted or error-free. 

 
17. Limitations on Export:  You hereby expressly agree not to export PC*MILER, in 

whole or in part, or any data derived therefrom, in violation of any export or 
other laws or regulations of the United States. 

 
18. Aggregated Data:  ALK may, from time to time, share information about You 

with parent and sister or affiliated companies for business purposes and when 
necessary for it to perform work under this Agreement.  In addition, ALK may, 
and is hereby authorized to, use, share and provide certain aggregated, non-
identifiable information derived from Your use of PC*MILER to third parties. 

 
19. ALK Cloud Feature:  ALK Cloud feature will store in anonymized way Your data 

in a cloud account in order to allow You to securely synchronize Your data with 
other users in Your organization.  End-user data is deemed the confidential 
information of end-user. For more information you may refer to ALK’s Privacy 
Policy. 

 
20. Additional Use Terms, Conditions, Restrictions and Obligations:  This 

agreement and your use of PC*MILER is expressly subject to the ALK Privacy 
Policy and the Navteq (HERE) and ALK End User License Agreement Terms 
and Conditions respectively  (“Navteq EULA”) and (“ALK EULA”) set forth 
below.  YOU ACKNOWLEDGE AND AGREE THAT YOU MAY NOT USE 
PC*MILER IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS OF 
BOTH THE NAVTEQ AND ALK EULA AND THAT YOU ACKNOWLEGE THAT 
YOU HAVE REVIEWED AND ACCEPT THE TERMS AND CONDITIONS OF 
BOTH THE NAVTEQ AND ALK EULA BY INSTALLING OR ACTUALLY USING 
PC*MILER. 

 
21. Miscellaneous:  This agreement shall be construed and applied in accordance 

with the laws of the State of New Jersey.  The Courts of the State of New 
Jersey shall be the exclusive forum for all actions or interpretation pertaining to 
this agreement.  Any amendments or addenda to this agreement shall be in 
writing executed by all parties hereto.  This is the entire agreement between the 
parties and supersedes any prior or contemporaneous agreements or 
understandings.  Should any provision of this agreement be found to be illegal 
or unenforceable, then only so much of this agreement as shall be illegal or 
unenforceable shall be stricken and the balance of this agreement shall remain 
in full force and effect. 

 
22. Date:  This EULA was last updated on June 4, 2016. Visit www.pcmiler.com for 

regular updates. 

 

http://www.pcmiler.com/
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END USER LICENSE AGREEMENT FOR NAVTEQ (HERE) DATA 
 
This licence applies to NAVTEQ data included in your Software, if any, as well as to 
NAVTEQ data you obtain separately that is formatted for use with your Software. 
 
The data (“Data”) is provided for your personal, internal use only and not for resale.  
It is protected by copyright, and is subject to the following terms and conditions 
which are agreed to by you, on the one hand, and ALK Technologies Inc. (“ALK”) 
and its licensors (including their licensors and suppliers) on the other hand. 
 
© 2016 NAVTEQ.  All rights reserved. 
 
Personal Use Only.  You agree to use this Data together with PC*MILER for the 
solely personal, non-commercial purposes for which you were licensed, and not for 
service bureau, time-sharing or other similar purposes.  Accordingly, but subject to 
the restrictions set forth in the following paragraphs, you may copy this Data only as 
necessary for your personal use to (i) view it, and (ii) save it, provided that you do 
not remove any copyright notices that appear and do not modify the Data in any 
way.  You agree not to otherwise reproduce, copy, modify, decompile, disassemble 
or reverse engineer any portion of this Data, and may not transfer or distribute it in 
any form, for any purpose, except to the extent permitted by mandatory laws. Multi-
disc sets may only be transferred or sold as a complete set as provided by ALK and 
not as a subset thereof. 
 
Restrictions.  Except where you have been specifically licensed to do so by ALK, 
and without limiting the preceding paragraph, you may not (a) use this Data with any 
products, systems, or applications installed or otherwise connected to or in 
communication with vehicles, capable of vehicle navigation, positioning, dispatch, 
real time route guidance, fleet management or similar applications; or (b) with or in 
communication with any positioning devices or any mobile or wireless-connected 
electronic or computer devices, including without limitation cellular phones, palmtop 
and handheld computers, pagers, and personal digital assistants or PDAs. 
 
Warning. The Data may contain inaccurate or incomplete information due to the 
passage of time, changing circumstances, sources used and the nature of collecting 
comprehensive geographic data, any of which may lead to incorrect results. 
 
No Warranty.  This Data is provided to you “as is,” and you agree to use it at your 
own risk.  ALK and its licensors (and their licensors and suppliers) make no 
guarantees, representations or warranties of any kind, express or implied, arising by 
law or otherwise, including but not limited to, content, quality, accuracy, 
completeness, effectiveness, reliability, fitness for a particular purpose, usefulness, 
use or results to be obtained from this Data, or that the Data or server will be 
uninterrupted or error-free. 
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Disclaimer of Warranty. ALK AND ITS LICENSORS (INCLUDING THEIR 
LICENSORS AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR 
IMPLIED, OF QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE OR NON-INFRINGEMENT.  Some States, Territories and 
Countries do not allow certain warranty exclusions, so to that extent the above 
exclusion may not apply to you. 
 
Disclaimer of Liability.  ALK AND ITS LICENSORS (INCLUDING THEIR 
LICENSORS AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT 
OF ANY CLAIM, DEMAND OR ACTION, IRRESPECTIVE OF THE NATURE OF 
THE CAUSE OF THE CLAIM, DEMAND OR ACTION ALLEGING ANY LOSS, 
INJURY OR DAMAGES, DIRECT OR INDIRECT, WHICH MAY RESULT FROM 
THE USE OR POSSESSION OF THE INFORMATION; OR FOR ANY LOSS OF 
PROFIT, REVENUE, CONTRACTS OR SAVINGS, OR ANY OTHER DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF YOUR USE OF OR INABILITY TO USE THIS INFORMATION, ANY 
DEFECT IN THE INFORMATION, OR THE BREACH OF THESE TERMS OR 
CONDITIONS, WHETHER IN AN ACTION IN CONTRACT OR TORT OR BASED 
ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.  Some States, Territories and Countries 
do not allow certain liability exclusions or damages limitations, so to that extent the 
above may not apply to you. 
 
Export Control.  You agree not to export from anywhere any part of the Data 
provided to you or any direct product thereof except in compliance with, and with all 
licenses and approvals required under, applicable export laws, rules and 
regulations. 
 
Entire Agreement.  These terms and conditions constitute the entire agreement 
between ALK (and its licensors, including their licensors and suppliers) and you 
pertaining to the subject matter hereof, and supersedes in their entirety any and all 
written or oral agreements previously existing between us with respect to such 
subject matter. 
 
Governing Law.  The above terms and conditions shall be governed by the laws of 
Illinois, without giving effect to (i) its conflict of laws provisions, or (ii) the United 
Nations Convention for Contracts for the International Sale of Goods, which is 
explicitly excluded.  You agree to submit to the jurisdiction of the Illinois for any and 
all disputes, claims and actions arising from or in connection with the Data provided 
to you hereunder. 
 
Government End Users: If the Data is being acquired by or on behalf of the United 
States Government or any other entity seeking or applying rights similar to those 
customarily claimed by the United States government, the Data is a “commercial 
item” as that term is defined at 48 C.F.R (“FAR”) 2.101, is licensed in accordance 
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with End-User Terms and each copy of Data delivered or otherwise furnished shall 
be marked and embedded as appropriate with the following “Notice of Use” and 
shall be treated in accordance with such Notice. 
 
Notice of Use 
Contractor (Manufacturer/Supplier) Name: NAVTEQ 
Contractor (Manufacturer/Supplier) Address: 425 W. Randolph Street, Chicago, 
Illinois 60606 
This Data is a commercial item as defined in FAR 2.101 and is subject to these End 
User Terms under which this Data was provided 
©2016 NAVTEQ- All rights reserved 
 
If the Contracting Officer, federal government agency, or any federal official refuses 
to use the legend provided herein, the Contracting Officer, federal government 
agency, or any federal official must notify NAVTEQ prior to seeking additional or 
alternative rights in the Data. 

 
 
END USER LICENSE AGREEMENT FOR ALK DATA  
 
This license applies to ALK Data included in PC*MILER if any, as well as to ALK 
data you obtain separately that is formatted for use with your Software. 
 
The data (“Data”) is provided for your personal, internal use only and not for resale.  
It is protected by copyright, and is subject to the following terms and conditions 
which are agreed to by you, on the one hand, and ALK Technologies, Inc. (“ALK”) 
and its licensors (including their licensors and suppliers) on the other hand. 
 
© 2016 ALK.  All rights reserved. 
 
1. Personal Use Only:  “You” means you as an End-user or as a “Company” on 

behalf of its End-Users which are subject to either a Non-Disclosure Agreement 
as employees or a License Agreement that contains the same restrictions as 
herein as a Value Added Reseller.  Also as used in this EULA “personal use” 
can also be understood in more general terms as for a Company’s use. You 
agree to use this Data together with PC*MILER for the solely personal, non-
commercial purposes for which you were licensed, and not for service bureau, 
time-sharing or other similar purposes.  Accordingly, but subject to the 
restrictions set forth in the following paragraphs, you may copy this Data only as 
necessary for your personal use to (i) view it, and (ii) save it, provided that you 
do not remove any copyright notices that appear and do not modify the Data in 
any way.  You agree not to otherwise reproduce copy, modify, decompile, 
disassemble or reverse engineer any portion of this Data, and may not transfer 
or distribute it in any form, for any purpose, except to the extent permitted by 
mandatory laws. 
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2. Restrictions:  Except where you have been specifically licensed to do so by ALK 
in the case of an integrated solution bundled or intended for use with specific 
smartphones, similar mobile communication device(s) or personal navigation 
device(s), and without limiting the preceding paragraph, you may not use this 
Data (a) with any products, systems, or applications installed or otherwise 
connected to or in communication with vehicles, capable of vehicle navigation, 
positioning, dispatch, real time route guidance, fleet management or similar 
applications; or (b) with or in communication with any positioning devices or any 
mobile or wireless-connected electronic or computer devices, including without 
limitation cellular phones, smartphones, palmtop and handheld computers, 
pagers, and personal digital assistants or PDAs. 

 
3. Warning:  The Data may contain inaccurate, untimely or incomplete information 

due to the passage of time, changing circumstances, sources used and the 
nature of collecting comprehensive geographic data, any of which may lead to 
incorrect results.  The Data is based on official highway maps, the Code of 
Federal Regulations, and information provided by state governments and other 
licensors.  It is provided without a warranty of any kind.  The user assumes full 
responsibility for any delay, expense, loss or damage that may occur as a result 
of use of the Data.  

 
4. No Warranty:  This Data is provided to you “as is,” and you agree to use it at 

your own risk.  ALK and its licensors (and their licensors and suppliers) make no 
guarantees, representations or warranties of any kind, express or implied, 
arising by law or otherwise, including but not limited to, content, quality, 
accuracy, completeness, effectiveness, reliability, fitness for a particular 
purpose, usefulness, use or results to be obtained from this Data, or that the 
Data or server will be uninterrupted or error-free. 

 
5. Disclaimer of Warranty:  ALK AND ITS LICENSORS (INCLUDING THEIR 

LICENSORS AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS 
OR IMPLIED, OF QUALITY, PERFORMANCE, MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT.  Some 
States, Territories and Countries do not allow certain warranty exclusions, so to 
that extent the above exclusion may not apply to you. 

 
6. Disclaimer of Liability:  ALK AND ITS LICENSORS (INCLUDING THEIR 

LICENSORS AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN 
RESPECT OF ANY CLAIM, DEMAND OR ACTION, IRRESPECTIVE OF THE 
NATURE OF THE CAUSE OF THE CLAIM, DEMAND OR ACTION ALLEGING 
ANY LOSS, INJURY OR DAMAGES, DIRECT OR INDIRECT, WHICH MAY 
RESULT FROM THE USE OR POSSESSION OF THE INFORMATION; OR 
FOR ANY LOSS OF PROFIT, REVENUE, CONTRACTS OR SAVINGS, OR 
ANY OTHER DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OF OR 
INABILITY TO USE THIS INFORMATION, ANY DEFECT IN THE 
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INFORMATION, OR THE BREACH OF THESE TERMS OR CONDITIONS, 
WHETHER IN AN ACTION IN CONTRACT OR TORT OR BASED ON A 
WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.  Some States, Territories and 
Countries do not allow certain liability exclusions or damages limitations, so to 
that extent the above may not apply to you. 

 
7. Export Control:  You agree not to export from anywhere any part of the Data 

provided to you or any direct product thereof except in compliance with and with 
all licenses and approvals required under, applicable export laws, rules and 
regulations. 

 
8. Entire Agreement:  These terms and conditions constitute the entire agreement 

between ALK (and its licensors, including their licensors and suppliers) and you 
pertaining to the subject matter hereof, and supersedes in their entirety any and 
all written or oral agreements previously existing between us with respect to 
such subject matter. 

 
9. Governing Law:  The above terms and conditions shall be governed by the laws 

of the State of New Jersey.  The courts of the State of New Jersey shall have 
exclusive jurisdiction to settle any and all disputes, claims and actions arising 
from or in connection with the Data provided to you hereunder.  You agree to 
submit to such jurisdiction. 

 
10. Canada:  DISCLOSURE FOR PRODUCTS CONTAINING CANADIAN POSTAL 

CODE AND/OR CANADIAN STREET-LEVEL DATA:  Based on Computer 
File(s) licensed from Statistics Canada. © Copyright, HER MAJESTY THE 
QUEEN IN RIGHT OF CANADA, as represented by the Minister of Industry, 
Statistics Canada 2003-2016. ALK Technologies, Inc. is an Authorized User of 
selected Statistics Canada Computer File(s) and Distributor of derived 
Information Products under Licensing Agreement 6147.  No confidential 
information about an individual, family, household, organisation or business has 
been obtained from Statistics Canada. 
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PC*MILER® for CICS and MVS/BATCH 

 

1.0  Introduction 
 
Congratulations!  By purchasing a PC*MILER product, you have made a cost-
effective investment in high quality software that is simple to learn and easy 
to use.  PC*MILER-CICS uses simple-to-follow screens and requires minimal 
keystrokes to generate mileage information.  In a matter of seconds you can 
calculate shortest, practical, national network and toll-avoidance miles, and 
determine cost and time estimates.  Your calculations can include up to 10 
stops.  
 
PC*MILER-CICS utilizes a unique distributed processing solution.  This 
solution maximizes the efficiency of your on-line transactions by "farming out" 
repetitive mileage calculations to a dedicated PC.  With PC*MILER-CICS, 
you can benefit from having a seamless mileage interface with your 
transportation management system.  ALK provides COBOL source code to 
the end-user to customize and integrate PC*MILER with other transportation 
management software.  An interface has been developed by ALK 
Technologies, Inc. for Distribution Sciences, Inc., to provide mileage to DSI's 
Base Rate®  system for on-line and batch processing.  
 

2.0  Hardware and Software Requirements 
 
Because PC*MILER-CICS and MVS/BATCH employs a distributed processing 
solution, the following additional hardware is required to use the software: 
 

• A dedicated PC with a 1.5-2 GHz processor and a minimum 512 MB of 
RAM (1 GB recommended). 

 
• Communication software from Zephyr Development Corporation, 

which can be downloaded using the link given below.  The product is 
called PASSPORT PC TO HOST via TN3270.  The PC*MILER-CICS 
application uses the HLLAPI api to transfer data between the PC and 
the mainframe.  HLLAPI (High Level Language Application Program 
Interface) is the industry standard method to interface Windows PC 
applications with host applications via 3270 terminal emulation.  ALK 
Technologies does not sell or provide technical support for the TN3270 
emulation software. 

 
The software can be downloaded at any time from the Zephyr website:  
http://www.zephyrcorp.com/downloads/index.htm?bodylink=true. 

http://www.zephyrcorp.com/downloads/index.htm?bodylink=true
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After the PASSPORT PC TO HOST and the PC*MILER-CICS 
products are installed, you need to ensure that the PC*MILER-CICS 
application can find the PASSPORT PC TO HOST hllapi dll by doing 
the following: 
 

1. Search for the folder that contains the WHLLAPI.DLL and search 
for the folder that contains the CICS.exe. 

2. Then, copy the WHLLAPI.DLL file from the PASSPORT folder to 
the folder that contains CICS.exe, and rename this copied file to 
“HLLAPI32.DLL”. 

For more information, please refer to the following article that can be 
found on the Zephyr Development Corporation website at 
http://www.zephyrcorp.com/api/hllapi-interface.htm . 

 

3.0  Installation 
 
You should have received the following with your purchase of PC*MILER-
CICS: 

 
• One copy of the PC*MILER product CD. 
• One CD containing the CICS Server.  
• A tape or cartridge containing the CICS resident software. 

 
Mainframe Installation 
 
1. Install the resident CICS and MVS/BATCH software on your mainframe.  

Three MVS based PDS's were copied to tape using IEBCOPY and 
standard label.  The order of files and their names are: 
 

• ALK.LOADLIB  
(run time software.  Record length=80 block size=12960 recfm=u) 

• ALK.SOURCE  
(COBOL source code.  Record length=80 block size=3120 
recfm=FB) 

• ALK.COPYLIB  
(copy books and maps. Record length=80 block size=3120 recfm=FB) 

 
At the end of this document you will find a printout of the JCL used to 
create the tape. 
 

2. Update the CICS resource definition or CSD file with the following 
FCT, PPT, and PCT parameters.  A description of the files is in the 

 

http://www.zephyrcorp.com/api/hllapi-interface.htm
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technical overview section.  These entries can be copied from 
ALK.SOURCE (TESTFCT). 

 FCT parms for three vsam files 
 DFHFCT TYPE=DATASET, 
 DATASET=DSMIDQUE, 
 DSNAME=DSV.PCMILE.MIDQUE,DISP=SHR, 
 ACCMETH=VSAM, 
 SERVREQ=(BROWSE,DELETE,READ,ADD,UPDATE), 
 FILSTAT=(ENABLED,CLOSED), 
 RECFORM=(FIXED,BLOCKED), 
 LOG=NO, 
 STRNO=4 
 
 DFHFCT TYPE=DATASET, 
 DATASET=DSOUTQUE, 
 DSNAME=DSV.PCMILE.OUTQUE,DISP=SHR, 
 ACCMETH=VSAM, 
 SERVREQ=(BROWSE,DELETE,READ,ADD,UPDATE), 
 FILSTAT=(ENABLED,CLOSED), 
 RECFORM=(FIXED,BLOCKED), 
 LOG=NO, 
 STRNO=4 
 
 DFHFCT TYPE=DATASET, 
 DATASET=DSBATQUE, 
 DSNAME=DSV.PCMILE.BATQUE,DISP=SHR, 
 ACCMETH=VSAM, 
 SERVREQ=(BROWSE,READ), 
 FILSTAT=(ENABLED,CLOSED), 
 RECFORM=(FIXED,BLOCKED), 
 LOG=NO, 
 STRNO=4 
 
 PCT parms for two transaction ID's 
 DFHPCT TYPE=ENTRY,TRANSID=PCM1,TWASIZE=0,PROGRAM=PCM 
 DFHPCTTYPE=ENTRY,TRANSID=SERV,TWASIZE=0,PROGRAM=SERVER 
 
 PPT parms for ALK programs 

DFHPPTTYPE=ENTRY,PROGRAM=DSPCM1,PGMLANG=COBOL,RES=YES 
 DFHPPT TYPE=ENTRY,PROGRAM=DSGETMIL,PGMLANG=COBOL 
 DFHPPT TYPE=ENTRY,PROGRAM=DSSERVEN,PGMLANG=COBOL 
 DFHPPT TYPE=ENTRY,PROGRAM=DSPCM,PGMLANG=COBOL,RES=YES 
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 PPT parms for ALK maps 
 DFHPPT TYPE=ENTRY,MAPSET=DSPC0SC (This is PCM1 screen) 
 
3. Submit the JCL called DEFPCMLE which deletes and defines three 

temporary vsam files 
 
4. Start up the updated CICS region or use CEMT NEWCOPY for updated 

programs.  For example, TYPE: CEMT SET PROGRAM(PCM1) 
NEWCOPY.  

 
PC Installation 
Install the CICS CD-ROMs onto your PC.  Place the CD in the CD drive.  
From the Start Menu select Run.  Then type: 
 

d:\ Setup   and press  <ENTER> 
 

4.0  Technical Support 
 
ALK Technologies offers one year of free unlimited technical support to all 
registered users of PC*MILER.  If you have any questions about 
PC*MILER|Connect or problems with the software that cannot be resolved 
using this User’s Guide, contact our staff:  
 
Phone: 609.683.0220, ext 2 
Fax: 609.252.8196 
Email: pcmsupport@alk.com 
Site: www.alk.com/support 
Hours: 8:00am – 5:30pm EST, Mon-Fri 
 
When calling, ask for “PC*MILER Technical Support”.  Please be sure to 
have your PC*MILER|Connect Product Key Code, version number, Windows 
version number, and hardware configuration information (manufacturer, 
speed, and monitor type) available before your call.  Please include this 
information in your message if you are contacting us by email. 
 

5.0  Accessing PC*MILER Product User Guides 
 
You must have Adobe Acrobat Reader on your computer to properly view a 
PC*MILER product’s user guide.  If you do not have this program installed 
already, a free copy can be downloaded from www.adobe.com.   
 

 

mailto:pcmsupport@alk.com
http://www.alk.com/support
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To make Adobe Reader your default reader, from within the Adobe Reader 
application select the Edit menu > Preferences > General and click Select 
Default PDF Handler.  Select Adobe Reader from the drop-down, and click 
Apply then OK to close the Preferences dialog. 
To view the user guide for any PC*MILER product without first opening an 
application, click the Windows Start button > All Programs (or the equivalent on 
your system) > PCMILER 30 > User Guides and select one of the .pdf files from 
the sub-menu. 
 
To search for a keyword or phrase in a user guide, use Adobe Reader’s Find 
option in the Edit menu or on the tool bar.   
 
All user guides can also be accessed at www.pcmiler.com/support. 
 

6.0  Starting and Stopping the Interface 
 
The software you installed on your dedicated PC will automatically start the 
interface and the MultiProtocol Workstation for Windows software when the 
PC is turned on.  
 
The key3270.txt file contains logon strings that will be keyed to the host one 
line at a time.  These strings are usually the user ID, password, and any other 
logon strings necessary to logon to the host.  3270 command keys such as 
<Enter> or function keys are preceded with an @ sign.  For example @E will 
simulate pressing <Enter> on a 3270 screen.  This file can be edited at 
installation time, or by using the Edit logon strings option, located within Logon 
Options in the File menu. 
 
 
Stopping the Interface 
From the PC*MILER - CICS window, choose Exit from the File menu.   

 

http://www.pcmiler.com/support
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7.0  Using PC*MILER for CICS 
 
To use PC*MILER - CICS, start the transaction PCM1.  The following screen 
will appear: 
 
 
_________________________________________________________________________________________ 
 S Routing Options:  P=Practical  S=Short  N=National  T=Toll Avoid 
  Functions:            R=Resequence  F=Reset fix dest  H=Hub miles 
  Zip, City/St or L/L                  Miles       Cum      Cost      Hours 
 
  Origin  :  ______________________ 
  Stop   1:  ______________________ 
  Stop   2:  ______________________ 
  Stop   3:  ______________________ 
  Stop   4:  ______________________ 
  Stop   5:  ______________________ 
  Stop   6:  ______________________ 
  Stop   7:  ______________________ 
  Stop   8:  ______________________ 
  Stop   9:  ______________________ 
 
 
  F3=Exit     F10=Process 
__________________________________________________________________________________ 
 
 
At the top of the main entry screen are several routing options settings that 
determine which type of miles will be generated when you process a route.  As 
shown, "S" is the default setting.  Other options include: <P> will instruct 
PC*MILER to generate practical miles;  <S> will instruct PC*MILER to generate 
shortest miles;  <N> will instruct PC*MILER to generate miles calculated using 
the National Network, which is designed for larger trucks;  <T> will instruct 
PC*MILER to avoid toll roads as much as possible.  To change the type of 
miles generated, type over the current setting.  (See the main PC*MILER 
User’s Guide for a description of routing options settings.) 
 
Under the routing options are function settings as follows: <R> resequences 
the stops you've entered to generate an optimal route, keeping the origin the 
same (see the Route Optimization section in the main PC*MILER User's 
Guide for more information); <F> resequences stops in an optimal route, 
keeping the origin and destination the same; <H> switches to HUB mode, 
which treats each stop as a destination so that mileage is generated from the 
origin to each stop (see the Hub Routing section in the main PC*MILER 
User's Guide).  To change the function setting, type over the current setting.  
The default setting is a blank space. 
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In the middle of the screen are the stop entry fields.  Enter either the city 
name and state abbreviations, the ZIP code, or the latitude/longitude position 
(example: 0333716N,1142709W) for the stop-off locations desired.  You may 
enter up to 10 stops. 
 
At the bottom of the screen, the function keys used with PC*MILER - CICS are 
described.  These include the following:  <F3> exits the program and returns to 
the main screen;  <F10> sends the mileage inquiry request to PC*MILER. 
 
Once you have entered stop(s) on the main screen and initiated a mileage 
inquiry by pressing <F10>, the following screen will appear: 
 
_____________________________________________________________________ 
 S        Routing Options:  P=Practical  S=Short  N=National  T=Toll Discouraged 
 
       City State or Zip  Miles Cum Cost     Hours 
 
  Stop   1:  KANSAS CITY KS____ 
  Stop   2:  OKLAHOMA CITYOK  335 335 369.16          6.2 
  Stop   3:  DALLAS TX_________  215 551 606.10        10.4 
  Stop   4:  ____________________ 
  Stop   5:  ____________________ 
  Stop   6:  ____________________ 
  Stop   7:  ____________________ 
  Stop   8:  ____________________ 
  Stop   9:  ____________________ 
  Stop 10:  ____________________ 
 
 
  F3=Exit  F10=Process 
 
 
This display contains leg and cumulative mileage for each segment of your 
trip.  The time and cost estimates are based on the values contained in the 
copy of PC*MILER installed on your dedicated PC.   
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8.0  Using PC*MILER With Other Transportation Software 
 
An interface has been developed for Distribution Sciences, Inc., by ALK 
Technologies, Inc., to provide mileage to their Base Rate system for on-line 
and batch processing.  Since mileage is an integral part of transportation, 
ALK has provided general purpose COBOL programs that can be accessed 
by in-house systems.  The following technical overview describes how these 
programs can be used. 
 
Technical Overview 
The PC*MILER-CICS system uses distributed processing techniques (i.e., the 
processing is split into two).  The user interface or interactive software is 
written in COBOL and runs on the mainframe in the CICS environment.  The 
mileage calculation software is written in C and runs on a PC in the Windows 
environment.  The mainframe COBOL programs communicate with the PC 
mileage calculation software through an interface board commonly known as 
"3270 emulation".  The interactive software on the mainframe allows multiple 
users to look up point to point mileage and calculate time and cost estimates 
for up to ten stop-off points. Additionally, ALK is providing COBOL source 
code so that other transportation software can access mileage information.  
The COBOL routines can be used for CICS on-line lookups or batch.  
Following is a list of the programs and a brief description of their use. 

 
 

CICS Programs 
 

Files Description   
DSPCM Main CICS COBOL program that xtls to DSPCM1.COB. 
DSPCM1 COBOL program uses DSPC0SC screen and links to DSGETMIL 
DSSERVEN PC*MILER main screen COBOL copy file. 
DSPC0SC BMS map file with dfh macros. 
 
DSGETMIL COBOL program exit that writes and reads VSAM ESDS files. 
 Pass ten city pairs -- it returns mileage, cost and time estimates. 
MIREQ Mileage request copy variables.  Contains city pair input 

mileage data structures for DSGETMIL. 
MIOUT Mileage request output copy variables.  Contains output 

mileage data structures for DSGETMIL. 
PCMCOM Miscellaneous copy variables. 
 
DSGETMI COBOL exit for rating software. 
 Pass two city pairs in R61UT01 and returns one mileage. 
 NOTE: This source is provided by Logility Transportation. 
R61UT01 User exit copy variables used by DSGETMI. 
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DSSERVEN SERVER program that reads and writes VSAM files and 
communicates with PC*MILER on the "PC". 

SERVSCR.COB SERVER Program's main screen COBOL copy file. 
DSPC0CR BMS map file with dfh macros. 
 

 
BATCH Programs 

 
MIBATCH BATCH exit for rating software. 
 Pass two city pairs in R61UT01 and returns one mileage. 
CALLBTCH Sample program that calls MIBATCH and passes two zip codes. 
BATCHJCL      JCL that invokes CALLBTCH. 
 
DEFPCMLE     JCL that deletes and defines three VSAM files. 
INPCMILE       COBOL program that writes low values records to three vsam files. 
DELBJCL JCL that deletes all records from DSBATQUE. 
DELBATQ COBOL program that deletes records from DSBATQUE 
 
VSAM Files       
DSMIDQUE CICS mileage input vsam file used by SERVER, GETMILES, 

and GETMI.COB  
 VSAM allocation attributes  
 NAME(DSV.PCMILE.MIDQUE) 
 KEYS(10,2) 
 ACCMETH=KSDS, 
 RECORDSIZE(256) 
 SHAREOPTIONS(2,3) 
 
DSBATQUE  Batch mileage input queue used by SERVER and 

MIBATCH.COBVSAM allocation attributes 
 NAME(DSV.PCMILE.DSBATQUE) 
 KEYS(10,2) 
 ACCMETH=KSDS, 
 RECORDSIZE(256) 
 SHAREOPTIONS(4,4) 

 
DSOUTQUE Mileage output queue 
 NAME(DSV.PCMLE.DSOUTQUE) 
 KEYS(10,2) 
 ACCMETH=KSDS, 
 RECORDSIZE(2313) 
 SHAREOPTIONS(4,4) 
   
 
1. (Request) The following are field parameters for requesting miles from 
copy book MIREQ.  The purpose of the Mileage request is to allow the host 
application to request just point-to-point miles.  This type of request could be 
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used for a quick mile lookup from a host inquire program or for running 
several stop-off points in a batch environment.  The host software could 
generate this request when a new trip is established. 
 

Var Name  Len Value Description 
 MI-REQ-TYPE 2 MI Miles request 
 
 MI-REQ-REF  10  CICS termid 
      or unique key for batch e.g. B085401897 
        
 MI-REQ-OPTION 10  Pos 1) S or P or N or T short, practical, 

national, toll avoid miles 
       Pos 2) M or K for miles or kilometers 
       Pos 3)  R = re sequence stops 
           H = hub leg miles 
           F = resequence stops fixed  
   destination 
                    blank = otherwise 
 MI-REQ-MORE   Pos 4)  M = more data to follow 
      Pos 5-10) Not used 
 MI-REQ-SEQ 4  Sequence for multi responses 
 MI-REQ-ERR 2  Error Code 
 MI-REQ-CIT  220  Array of 10 cities 22 bytes each 
      Specify city name or 5-digit  ZIP 
      Specify ZIP first if ZIP and city is specified   
      16 positions for ZIP code and/or city name 
      2 positions for the state abbreviation  
      Host Software city code (up to 4 characters) 
 FILL8    7  Filler with blanks 
 B256     1   Character "R" in position 256 
 
 
1. (Response) The following are field parameters for output miles from copy 
book MIOUT.  The City Pair response returns an output to the host 
application that contains city names and zip codes along with miles, cost and 
time estimates. 
 
 Var Name  Len Value Description 
 MI-OUT1-TYPE 2 CP City pair returned output 
 MI-OUT1-REF 10  CICS termid or batch key 
        
 MI-OUT1-NET 10  Pos 1) S or P for shortest or Practical miles 
 MI-OUT1-MIL-TYPE  Pos 2) M or K for miles or kilometers 
 MI-OUT1-OPTION    Pos 3)  R = resequence stops 
        H = hub leg miles 
            F = resequence stops fixed destination 
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        blank = otherwise 
MI-OUT1-MORE   Pos 4) M = more data to follow 

      Pos 5-10) Not used 
 MI-OUT!-SEQ 4  Sequence for multi responses 
 MI-OUT1-ERR 2  Error Code 
     E1 First state not found 
     E2 First city not found 
     E3 Second state not found 
     E4 Second city not found 
     E5 Unable to resequence 
 MI-OUT1-CIT1 27  City  one 27 bytes  
      ZIP code (if available for city) 
      16 positions for zip code and city name 
      2 positions for the state abbr.  
      Host Software city code (up to 4 characters) 
 MI-OUT1-CIT2 27  City  two 27 bytes 
      ZIP code (if available for city) 
      16 positions for zip code and city name 
      2 positions for the state abbreviation  
      Host Software city code (up to 4 characters) 
 MI-OUT1-MILE 5  Total miles returned 
 MI-OUT1-HOUR 4  Total time in hours (0031) = 3.1 hours 
 MI-OUT!-COST 7  Total cost for city pair (0052295) = 522.95  
 FILL158  158           
 O256     Blank      
    
 
2. (Request) The following are field parameters for a state miles request.  The 
purpose of this request is to attain the state-by-state mileage information 
associated with a trip. (NOTE: Copy books have not been coded for the 
following requests, but PC*MILER will support these requests.  For example, 
if  characters SM is inserted into the MIREQ copy variable MI-REQ-TYPE, 
PC*MILER will return an additional record containing state miles.) 
   
 Request from Host Len Value Description  
 REQTYPE  2 SM State miles request    
 REFNUM  10  CICS term id     
 PARAMS  10  Parameters (10 position field)  
      Pos 1)  S or P for shortest or Practical miles 
      Pos 2) M or K for miles or kilometers 
      Pos 3) R = resequence stops  
        H = hub leg miles 
            F = resequence stops fixed  
  destination 
         blank = otherwise 
      Pos 4)  M = more data to follow 
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      Pos 5-10) Not used 
 SEQNUM  4  Sequence for multi responses 
 ERROR  2  Error Code 
 CITIES  220  Array of 10 cities 22 bytes each 
      Specify city name or 5 digit  ZIP 
      Specify ZIP first if ZIP and city is specified   
      16 positions for ZIP code and/or city name 
      2 positions for the state abbreviation  
      4 Host Software city code (up to 4  
 characters) 
 FILLER  7    
 HOSTREQ  1  Character "R" in position 256 

 
 
2. (Response) The following are field parameters for the state miles output.  The 
PC will respond with the miles (or kilometers) for the stops indicated in the "SM" 
request.  For each record, mileage for ten (10) states will be returned.  If 
additional records are needed, an "M" in the "MORE" parameters field is used to 
indicate that there is more data to follow.  NOTE:  The "HS" request will also 
cause an "SR" output record to follow the "CP" City Pair output record. 

         
 Response from PC Len Value Description  
 REQTYPE  2 SR State miles summary 
 REFNUM  10  CICS term id 
 PARAMS  10  Parameters (10 position field) 
       Pos   1) S or P for shortest or Practical miles 
       Pos 2) M or K for miles or kilometers 
       Pos 3) R = resequence stops 
          H = hub leg miles 
            F = resequence stops fixed  
  destination 
         blank = otherwise 
      Pos 4) M = more data to follow 
      Pos 5-10) Not used 
 SEQNUM  4  Sequence for multi responses 
 ERROR  2  Error Code 
     E1 First state not found 
     E2 First city not found 
     E3 Second state not found 
     E4 Second city not found 
     E5 Unable to resequence 
 
 STATEMIL  220  10 elements each element will consist of: 
      2 for state code 
      5 for total miles 
      4 for toll miles 
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 FILLER  8      
 
3. (Request) Following are parameters for a route info and state miles 
request.  The purpose of this request is to allow the Host to retrieve detailed 
route information based on the city pair stop-off points. 
        
 Request from Host Len Value Description  
 REQTYPE  2 HS Routes and  State miles 
 REFNUM  10  CICS term id      
            
 PARAMS  10  Parameters (10 position field) 
       Pos 1) S or P for shortest or Practical miles 
       Pos 2)  M or K for miles or kilometers 
       Pos 3)   R= resequence stops 

        H= hub leg miles       
                   F = resequence stops fixed  

   destination 
          blank = otherwise 
      Pos 4)  M = more data to follow 
      Pos 5-10) Not used 
 SEQNUM  4  Sequence for multi responses 
 ERROR  2  Error code 
 CITIES  220  Array of 10 cities 22 bytes each 
      Specify city name or 5-digit ZIP 
      Specify ZIP first if ZIP and city is specified 
      16 positions for ZIP code and/or city name 
      2 positions for the state abbreviation 
      4 Host Software city code (up to 4  
 characters) 
 FILLER  7 
 HOSTREQ  1  Character "R" in position 256 
 
 
3. (Response) Following are field parameters for a response to the route info 
and state miles request.  The PC response record has all of the detailed 
route information that is required.  There are 4 route list records/response 
records.  Therefore, if there are more than 4 records for the route, additional 
response records must be returned.  Multiple returned records are designated 
by the "M" in the "MORE" parameter field. 
 
 Response from PC Len Value Description 
 REQTYPE  2 HR Route highway information returned 
 REFNUM  10  AS400/SYS38: Job # from ext data struct 
      SYS 36: Field not in use 
      IBM 370 mainframe: userid or account name 
      Windows, Unix: Response file name 
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      Wang: user account or not used 
 PARAMS  10  Parameters (10 position field) 
      Pos 1) S or P for shortest or Practical miles 
      Pos 2)  M or K for miles or kilometers 
      Pos 3) R = resequence stops 
        H = hub leg miles 
        F = resequence stops fixed  
  destination 
        blank = otherwise 
      Pos 4)  M = more data to follow 
      Pos 5-10) Not used 
 SEQNUM  4  Sequence for multi responses 

 
 ERROR  2  Error code 
     E1 First state not found 
     E2 First city not found 
     E3 Second state not found 
     E4 Second city not found 
     E5 Unable to resequence 
 
 ROUTEINFO  224  4 elements, each element will consist of: 
      2 indicates end of route records for stop 
      2 state code 
      2 blanks 
      1 toll indicator 
      1 blank 
      1 directional (n,s,e,w) 
      1 blank 
      7 route number 
      4 leg mileage 
      2 blank 
      19 for intersection city or junction 
      8 for cumulative leg miles 
      6 for cumulative stop miles 
 FILLER   4     
       
 
NOTES: The PC will send CP response records for MI requests. 
 The PC will send CP and SR response records for SM requests. 
 The PC will send CP, SR, and HR response records for HS requests. 
 
See next page for sample request records. 
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Sample State mile "SM" request record: 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                              
 
 
 
 
Sample State mile "SR" response record:  

       
 

 
 
 

SMTOM   SM    0001     PRINCETON   NJ  SAN DIEGO   CA 

State Mile request type 

Response queue or  
file name is "TOM" 

Shortest Routing Report distances in Miles City name is  
"PRINCETON NJ" 

City name is  
"SAN DIEGO CA" Sequence # is 0001 

R 

Character "R"  
In position 256-  
indicates "Request" 

CPTOM  SM M 0001   08540PRINCETON  NJ   92128SAN DIEGO     CA HH027270514031  

   (record continNM003730000OH002260000OK003420150PA003500267  
SRTOM  SM   0003   TX001800000WV000140000   

Response type:  
City pair record  
and state miles 

"M"=More data to follow  
for first two records 

Incremental   
request # 's 

Data record response area  
(see previous pages for positions) MILES

 

SRTOM  SM M 0002  AZ004430000CA001770000IL001490000IN0015510000MO003110000NJ 

 



 16 PC*MILER for CICS and MVS/Batch User’s Guide 

 

Appendix:  JCL File  
 
(Used to create the tape for MVS only.  ALK has source in 
Windows PC format for uploading if needed.) 
 
 
//XALK005B JOB (TE,IDB,,2010,1,10),'TAPE JOB',USER=XALK003, 
// CLASS=9,MSGCLASS=H,NOTIFY=XALK003,REGION=2048K      
//* THIS JCL DOES AN IEBCOPY TO LOAD CICSDEV.ALK.LOADLIB, 
//*   CICSDEV.ALK.SOURCE AND CICSDEV.ALK.COPYLIB                
//*   TO TAPE.                                                           
/*MOUNTS  T=1 
//******************************************************************* 
//*   THIS JOB WILL WRITE ON OLD STYLE REEL TAPE 
//*   CREATED USING IEBCOPY AS SHOWN BELOW        
//******************************************************************* 
//BACKUP0  EXEC PGM=IEBCOPY 
//SYSPRINT DD SYSOUT=* 
//IN01     DD DSN=CICSDEV.ALK.LOADLIB,DISP=(SHR) 
//*                                                                                           
//OUT01    DD DSN=ALK.LOADLIB,UNIT=(TAPE,1), 
//         VOL=(,RETAIN,,,SER=560128), 
//         LABEL=(1,SL,EXPDT=98000),DISP=(,KEEP,DELETE), 
//         DCB=TRTCH=NOCOMP 
//IN02     DD DSN=CICSDEV.ALK.SOURCE,DISP=(SHR) 
//*                                                                                          
//OUT02    DD DSN=ALK.SOURCE,UNIT=AFF=OUT01, 
//         VOL=(,RETAIN,,,REF=*.OUT01), 
//         LABEL=(2,SL,EXPDT=98000),DISP=(,KEEP,DELETE), 
//         DCB=TRTCH=NOCOMP 
//IN03     DD DSN=CICSDEV.ALK.COPYLIB,DISP=(SHR) 
//*                                                                                          
//OUT03    DD DSN=ALK.COPYLIB,UNIT=AFF=OUT01, 
//         VOL=(,RETAIN,,,REF=*.OUT01), 
//         LABEL=(3,SL,EXPDT=98000),DISP=(,KEEP,DELETE), 
//         DCB=TRTCH=NOCOMP 
//SYSUT3 DD UNIT=SYSDA,SPACE=(CYL,(1,1)) 
//SYSUT4 DD UNIT=SYSDA,SPACE=(CYL,(1,1)) 
//SYSIN DD * 
 C I=((IN01,R)),O=OUT01 
 C I=((IN02,R)),O=OUT02 
 C I=((IN03,R)),O=OUT03 
// 
//         VOL=(,RETAIN), 
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